CNC Jr.

USER’S MANUAL
2.0 Setting up Your CNC Jr.

3.0 Connecting Electrical Power

3.0 Setup the CNCMASTER or host computer to the CNC Jr.

4.0 MASTER Software Installation.

5.0 CNC Jr. Options
  5.1 Variable Speed Drive
  5.2 Engraving Attachment
  5.3 Rotary Table
  5.4 Quick Tool Changing System
  5.5 Lubrication System
  5.6 Coolant

5.7 G-CODES File Interpreter Option

5.8 CNCMASTER

5.9 XYZCAD-CAM

6.0 MASTER Software Features

6.1 Help Menu

6.2 The Screen

6.3 The Setup Program

6.4 My First Program

6.5 Teach Mode

6.6 The File Menu

6.7 The Edit Menu

6.8 The Run Menu

6.9 The Option Menu

7.0 MASTER Command List
Bolt the CNC Mill on either the optional machine stand or a sturdy work bench with four 3/8’ or 1/2’ diameter bolts. It is recommended that the work bench height be about 30 inches high depending upon the operators preference.

2.0 Setting up Your CNC Jr.

Your CNC Jr. has been completely tested and run at the factory before shipment to ensure all features are functional. Damage or components may go out of adjustment during shipment, so it is recommended that the following components be checked and adjusted as necessary prior to connecting the CNC Jr. to a power source.

After bolting the Mill to the machine stand or bench, assembly the Y AXIS as follows:

IMPORTANT! DO NOT ROTATE THE Y AXIS SCREW UNTIL ASSY. IS COMPLETED OR BALL NUT WILL GET DISMANTLED!

Remove the two 5/16 screws which hold assy. Detach the belt cover and swing motor bracket to the left. Discard the 5/16 washer included. Reposition the two 5/16 screws to secure bracket. Insert a 0.5’ socket wrench through the 3/4’ dia. clearance hole and secure motor bracket to the body of the mill end-plate with the two supplied screws with lock washers only. Reposition belt on pulleys. If the belt needs adjustment, loosen the four motor screws, place a flat screwdriver between motor and bracket and adjust the belt tension as required. The belt should not have more than 1/4’ deflection at midpoint. Re tighten motor screws. Attach belt cover.

Next clean shipping grease from all shiny surfaces on table and quill using a suitable solvent. Oil ways and other lubrication points as described in Manual for the Mill.

Adjust jib strip bolts for a loose fit for the initial testing of the CNC Jr. After initial testing and periodically during operation of the CNC Jr. adjust jib strip bolts to remove table slack following the directions in the Manual for the Mill.

Unplug the axis motor connectors for manual operation. Using the rotary handles, run the X and Y axis back and forth to determine if the tables are moving freely. A slight drag should be felt
call J & S Products for further assistance at (714) 552-1158.

The quill or Z axis should easily move up or down manually by loosening the center knob and using the drill press type handles. The center knob on the drill press handle when tightened locks in the micro down feed. The Z axis stepper motor drives this micro down feed feature to control the Z axis feed rate. When running under CNC control tighten this center knob to lock in the micro down feed.

Next check and adjust the belt tension on the spindle drive. If your CNC Jr. has manual spindle control you can select the desired RPM by moving the belts to proper position as indicated on the speed chart attached to mill. If you have the variable speed spindle drive option the belts should come preset to belt 2-7 position as indicated on the speed chart or 1040 RPM. Refer to section 5.1 for further details on the variable speed drive option.

3.0 Connecting Electrical Power

Three components of your CNC Jr. require electrical power. These components are the 2 HP spindle drive motor, the controller, and the CNCMASTER or host computer. The controller and the CNCMASTER computer require 120 Volts, single phase, 60 cycle power. Plug the controller and computer in a good quality computer type surge suppresser to protect this equipment from electrical surges. Also check that line voltage does not exceed 122 Volts AC. If this is the case then you must use a 600 watts (minimum) line conditioner to maintain voltage at 120 or less.

Electrical power for the spindle motor has several options available depending upon whether the variable speed spindle control was purchased as an option. These options are listed as follows for manual spindle control and variable speed spindle control:

**MANUAL SPINDLE CONTROL**

Option 1: 240 Volt, three phase, 60 cycle, 20 amp service.

Option 2: 240 Volt, single phase, 60 cycle, 20 amp service with phase converter.

Option 3: 120 Volt, single phase, 60 cycle, 20 amp service.
circuits protected with separate circuit breakers in the main panel board be used to protect the computer and the controller from voltage drops or spikes when the 2 HP spindle motor is started and stopped. Damage to your computer and controller may occur if the electrical power supply is not adequate. Use a licensed electrician to check or modify your electrical wiring if you are not sure about its capabilities.

Variable Speed Spindle Drive Additional Information

The variable speed drive option provides a variable frequency and variable voltage output to the spindle motor. This drive allows the motor to run from 0 RPM to the maximum rated RPM of the motor with very little loss of torque.

3.0 Setup the CNCMASTER or host computer to the CNC Jr.

$INSTALLATION

Attach the CNCMASTER to the support bracket using a 5/16 by 1-1/2 inches long, coarse thread, hex head screw and washer. Do not use a longer screw or you may damage the base of the CNCMASTER.

It is recommended that a 486DX or higher IBM compatible computer is used to operate the CNC Jr.

The initial setup for the operation of the CNC Jr. is quite simple. If you have a variable spindle then plug-in the corresponding 240VAC line first. Do not ever plug or unplug this line while the CNC JR. controller or computer is turned on.

Make sure that each motor cable is plugged into the correct connector of the controller. Plug the printer cord from the CNCMASTER into the CNC Jr. controller and the power cords of the computer and controller into a 120 VAC.

Once all the connections are made as indicated, turn the computer on and run the MASTER software. Switch the power on the CNC JR. control unit. The screen displays DRIVERS:OFF, it will change it to DRIVERS: OK. If DRIVERS are still OFF then press and release the KILL button on the CNCMASTER (for a host computer, press and release the reset button on the CNC Jr. control unit).

If the CNCMASTER display is indicating DRIVERS:OK then press the
4.0 MASTER Software Installation.

The CNCMASTER comes with the software factory installed. For other computers do the following: Insert the MASTER diskette into either the A or B drive of your computer. Use the DOS command A: or B: to change to either the A or B drive. Type INSTALL and then press the [ENTER] key. The installation program will create a subdirectory on the C drive for the MASTER software. After installation is completed, type the word MASTER to start the software.

5.0 CNC Jr. Options

5.1 Variable Spindle Speed Drive

Initial setup of the variable speed drive requires turning off controller, then plugging the variable speed drive unit into a 240 volt, single phase, 20 amp circuit. Plug the 5 pin female connector from the variable controller to the CNC Jr. variable output port.

Start CNCMASTER, turn controller on, press and release the KILL button or the reset switch on the controller. Press and release the PORT ON/OFF button ( or the [F5] key on the host computer) to turn the PORT: ON. The spindle speed now can be controlled by either using the SPINDLE command (EX: SPINDLE ON FORWARD SPEED 1500) or using the menu. Press [ALT]+[O] to select options then press [O] to turn spindle ON. Press [ALT]+[O] again then either one of the following letters: F, W, R or S to set Off, Forward, Reverse or Spindle speed.

The spindle should be turned off using either the SPINDLE OFF command or by selecting Spindle Off in the options menu before turning the controller off and exiting MASTER.

5.2 Engraving Attachment with variable speed

WARNING: DO NOT PLUG ANY ROUTER LARGER THAN A ¾ HP OR THE DRIVER WILL BE DAMAGE!
Plug the power cord of the variable router controller into a 120 Volts AC outlet. Make sure that the router controller power switch is off. Plug in the 5 pin female router control line into the variable speed port of the CNC Jr. controller. If you have a variable spindle attachment on your machine then you must exchange corresponding connectors whenever you are using the variable router or the variable spindle controls.
The CNC Jr. has 4 axis capabilities using the rotary table option. Mount the rotary table to mill table and plug the cable from the stepper motor into the W axis connection on the Controller. Now the rotary table can be controlled by the W joykeys on the CNCHMASTER (use the [HOME] and [END] keys in a host computer) or commands that have a W axis option such as MOVE.

5.4 Quick Tool Changing System

This system has a master tool holder which features a R8 taper holder. It is held in by the draw bar. The Tool holders can be quickly released by pressing a button and a twist on the tool master. A new tool is attached by simply pressing the tool holder into the tool master. Tool holders come in a variety of sizes to hold various sized mills and chucks. MASTER software allows 10 tool setups.

Contact J & S Products for a list of quick change tool holders that are available.

5.5 Lubrication System

The oil reservoir is attached under the speed belt housing. Pull the oil reservoir out and fill it with oil. Plug the power cord from the oil reservoir into the 120 Volts AC outlet labeled 'oil' on the CNC Jr. control. Warning!: Do not use this outlet to drive a load larger than .5 amps or the control will be damaged. When the CNCHMASTER is running, it will automatically lubricate several critical points on the CNC Jr., which include all the table ways, ballscrews, and the Z axis. The oil is distributed through a capillary harness and the flow is controlled through an electrical valve on the oil reservoir. The MASTER software allows you to program the frequency of oil amounts desired that will flow into the machine while it is running. See the AUTO OIL command for more information.

Regular motor oil 5W-30 work well with the lubrication system.

The milling machine has other oiling points which must be serviced regularly.
controller will be damaged.

The coolant kit does not contain a spray head or attachments to control the coolant flow due to a large variety of spray heads available. Select one from your local machine tool distributor or from any of the mail order suppliers.

5.7 G-CODES File Interpreter Option

With the G-CODES file interpreter option, G-Codes produced from other CAD/CAM programs can be read and used by the MASTER software. If the G-code file is large then it is recommended to insert a ‘RUNFILE’ command in your program (Ex: RUNFILE C:\BOBCAD\GFILE.TAP). If the G-code program is short then you may choose to copy it into your program code: press the [ALT]+[F] for the file menu then press [I] to insert a file. Type the file name and the G-CODE file will be inserted. G-CODE file must have a .TAP extension to be used (Ex: C:\BOBCAD\TEST.TAP). For further details see MASTER help file HELPMENU.TXT.

5.8 The $CNCMASTER

Besides the features of a regular computer, the CMASTER has several control functions placed above the keyboard. Starting from left to right:

The PORT ON/OFF, PAUSE button: (1) Turns the port on or off. (2) Exits jog mode if the jog mode is active. (3) Pauses a running program. A second button press will abort the paused program.

The GO button: (1) Runs the open program. (2) Will continue running a program that was paused.

The X, Y joykeys and the Z, W joykeys: Will activate jogging in the selected axis. The W axis is the rotary table. The PORT must be ON. The jog speed is controlled by the FEED dial.

The MICRO JOG dial: Has a micrometer function. Turning CW or CCW will increment or decrement the position of the selected axis. The increments (or decrements) are in 0.00025’ steps. The FEED dial must point to the MICRO JOG function. Select the axis with the joykeys.
run, the SPINDLE SPEED OVERRIDE function will be active. Turning CW or CCW will increment or decrement the spindle speed. The percentage of change is displayed on the screen. Set the SPINDLE SPEED OVERRIDE to zero position before running a program.

The KILL button: Pressing the KILL button will reset the CNC Jr. controller and lock the running program. Press the KILL button a second time to unlock the MASTER and continue working with the editor.

5.9 XYZCAD-CAM

For installation and usage follow the XYXCAD-CAM user’s manual instructions.

Note: If needed, a software lock key can be plug between the CNC Jr. controller and the printer cable connection.

6.0 MASTER Software Features

6.1 $HELP_MENU

You can reach the Help Menu with the [F1] key at any time while editing a program. From the editing screen move the cursor to select a particular command line; then press the help key [F1] to open a menu and select L for an explanation of the command selected by the cursor. The escape key [Esc] will close the help window. You can find other commands available in the Insert Menu with the [Ins] key. As before, select a particular command and press the [F1] key.

6.2 $THE_SCREEN

This is your main working area. Here you can create and view your file of motion commands. The top and bottom lines (highlighted text) are the prompt lines. The prompt lines will display the options available at any particular level that you are in. The three lines before the bottom prompt line are the status lines which show the status of the different options available. You may
use the arrow keys) and other keys as shown on the bottom prompt line. You can change from micro to rapid Jog speeds by selecting the FEED dial. During the JOG mode you may also enter the [INS] key to automatically insert and save the new position (see the Teach Mode for more information), or you can enter the [S] key to save the program home position (see the SET HOME command).

6.3 $SETUP_PROG

The setup program defines the default startup parameters necessary to run your machine. The default values can be overridden by another command line. Depending on your system, commands like BACKLASH, REVERSE, RAPID, SCALE, INCHES, etc., may be entered and modified in the setup file.

Access the setup program (or any other program) with either one of the following two methods:
1. Press [F3], type SETUP and then press the [ENTER] key.
2. Press [F4], type the coded number listed for the setup program then press the [ENTER] key.

Press the [F2] key to save the setup program after making any changes.

With the CNCMASTER computer, use the joykey controls to set the proper direction of the motors. Notice that the +X, -X, +Y, -Y, refer to the cutter tool direction and not to the direction of the table, which happens to be opposite. To change the jogging speed use the FEED dial.

Hold the joykey towards the +X position and the table should move to the left (assuming that you are facing the mill). Hold the joykey towards the +Y position and the table should move backwards. Hold the joykey towards the +Z position and the quill should move up.

If there are directional errors, then exit the jog mode by pressing the PORT ON/OFF button and then move the cursor to the REVERSE command line in the SETUP program; press the [Tab] key and change the corresponding field. Press the [F2] key to save the change done. Activate joykeys to verify corrected axis direction. You may press the help key [F1] for additional information.

With a host computer, follow the same setup logic shown above and use the keyboard alternate commands:
[F5] for Port ON/OFF.
If there is a loaded program on the screen then press the 
[Alt]+[F] and select N for NEW. This will clear the screen and 
the memory buffers. For an exercise you will make a 1’ square. 
Press [Ins] key to enter into the insert menu and type RA to 
select RAPID speed. Press [Enter] to complete your first command. 
Press [Ins] and type MO to select move. The word MOVE will appear 
on a new command line. 
Always use the [Tab] key to start editing a command line and a 
space between key words and data. 
Now use the [TAB] key + SPACE BAR to go to the first blank space 
after the word MOVE. Enter X1.0 for the first move and press the 
[Enter] key to complete the command. Now press the [Ins] key 
followed by the [Enter] key. This sequence will repeat the 
previous inserted command. For this new line type Y1.0. Repeat 
the above procedures for X-1.0 and Y-1.0. Finish by inserting and 
END command line. All programs must terminate with an END command 
line. 
Verify graphically your data by depressing [F6]. Your program is 
now ready to run. With the [F2] key save your program and name 
it, for example TEST. Select Port ON and verify in status area of 
the screen. 
Press the GO button to run the program. The quill will move 1’ 
square. Now, lets extend the TEST program and add a drilled hole 
at each corner of the square. First you will write a subprogram 
or routine to move the Z axis .250 down and back. Go to one line 
after the END and [Ins] RL for a Routine label. Enter DRILL as 
the name of the routine. Now [Ins] FE to select feed speed and 
enter 5 after the FEED; [Ins] MO and enter Z-.250; [Ins] RA to 
select rapid speed; [Ins] MO and enter Z.250; [Ins] EN to END the 
call routine. Go to the main program (not the routine) and [Ins] 
CA after each MOVE line. Each call line should read  CALL DRILL 
1. A number after a call label (DRILL) tells the MASTER software 
to repeat the routine (in this case is only once). Save this 
program and name it TEST1. 
To save under a different name press [Alt]+[F] and select <a> to 
<Save as> and answer the questions. Now, you may run your 
program. Use the trace [F8] key to understand how a Call routine 
works. You may compare your programs TEST and TEST1 against 
Sample1 and Sample2 supplied with your software. They should be 
the same. Now that you have seen how easy it is to program with 
the MASTER software, you should load and study the other sample 
programs included in your software. Sample3 uses the ARC command; 
sample4 shows how to run a G-code program located in the BOBCAD
your machine. The steps to follow are quite simple:
First, you must determine the home or zero position of the part clamped on the milling table. One method will be to use an edge finder and the Jog mode to zero the X, Y and Z counters. Now using the Jog mode, start machining your part and use the [Ins] key to automatically insert and save the current position you are in. You must use your best judgment in order to determine which positions while machining, are best to save. You can leave the jog mode any time and [Ins] from the insert menu any command like arc, polar move, etc., which will be difficult or impossible to duplicate with the jog keys. After you have entered the command, press the [F10] key for immediate execution. Any time during your machining you may insert rapid or feed commands as required. Insure that with the last move command you return to home or zero position, and add the word END as the last line.

6.6 The File Menu

HELP_FILE
Use [PgDn] key to find the following commands:
GET FILE
SAVE
SAVE AS
INSERT A FILE
DIRECTORY
PRINT
EXIT

GET FILE
Use the [F3] function key from the main menu. This command allows you to retrieve or open any file that has been created with CNC JR. software. Before loading you will be asked to save any changes on your present file.

SAVE
Use the [F2] function key from the main menu. The SAVE command allows you to store your current file in the directory. If the file name is NONAME then you will be asked for a new name.

SAVE AS
Use the [a] key at this time to save a file under a different name.

INSERT A FILE
Use the [M] key at this time to insert a file at the cursor position. The file to be inserted must have .TAP or .CNC as a
DIRECTORY
Use the [F4] function key from the main menu. This command shows all files in the present directory. You will have the option of loading a program by entering the coded number followed by [Enter] or you may leave the directory with the [Esc] key follow by the [Enter] key. You can change directories with the [F5] function; but, make sure that the directories have been already created by DOS.

PRINT
Use the [P] key at this time to print the current file. To print from the CNCMASTER, connect the parallel port to the printer.

EXIT
Use [ALT]+[X] key to leave CNC JR.. If there have been any changes since the last time you saved the file, CNC JR. will give you a warning that all the additional changes will be lost.

6.7 The Edit Menu

$HELP_EDIT
Use the [PgDn] key to find the following commands:
INSERT
DELETE
UNDELETE
CHANGE TEXT
ZERO COUNTERS

INSERT
The [Ins] key opens a menu from which you can select the different commands available to build a file. The insertion is done at the cursor current position. After you have made your selection. To repeat the last command you entered, press the [Enter] key after the [INS] key.

DELETE/UNDELETE
Pressing the [Del] key erases the command at the present cursor position. To UNDELETE the last deleted line press [Alt]+[E] to get into the Edit menu and enter [U] to undelete. You can move the cursor to a different line and insert the deleted line.

EDIT TEXT
Press the [Tab] key to get into the edit mode. When finish, press the [Enter] key or [Esc] key to abort edit.
TRACE
IMMEDIATE
ESCAPE
FREE JOG
PROGRAM HOME
MACHINE HOME
SHOW HOME

RUN
The [Ctrl]+[F9] combination key will execute the current program on the screen from the first program line until END is found. If it finds a CALL command, it will execute and repeat the call routine as indicated by the call repeat option.

TRACE
The [F8] function key allows you to step your program one line at a time starting at the first program line. You may terminate this mode with the [ESC] key, or continue without interruption with the [Ctrl]+[F9] key. You may also enter [F5] for further program control.

IMMEDIATE
The [F10] function key allows immediate execution of a command. Move the cursor to any command line and press the [F10] key for immediate execution. You may use this command after you have entered a new line during the teach mode.

ESCAPE
The [ESC] key is active in every level of the program. It will cancel any command in progress and bring you back to the editing screen. It is a good escape from any inadvertently entered command. Use it to stop a running program.

FREE JOG
With the CNCMASTER computer, press the joykeys to start jogging. The motor counters keep track of the motor displacement. The jog speed can be quickly changed with the FEED dial. The FEED dial can enable the MICRO JOG function dial for micro-stepping. The MICRO JOG dial has a micrometer function. Turning CW or CCW will increment or decrement the position of the selected axis. The increments (or decrements) are in 0.00025’ steps. Select the axis with the joykeys.

You may enter X, Y, Z or W to zero the corresponding counter. The [F7] key will zero all counters.
PROGRAM HOME
You can set the program home by jogging the axis and zero their respective counter at any convenient position of the machine working area. To return to the PROGRAM HOME press [ALT]+[H] keys.

MACHINE HOME
To set the machine home press [Alt]+[M] keys. The X, Y and Z axis will travel and search for the home switches, where the machine home will be reset. From here, jog your way to the new program home. Before you exit the jog mode, press [S] to save the offset distance from the machine home to the program home. See the SET HOME command.

SHOW MACHINE HOME
Press [ALT]+[S] keys to display the distance from the machine home to the program home. Save and enter these values in the SET HOME command.

6.9 The Option Menu

$HELP_OPTIONS
Use [PgDn] key to find the following commands:

SPINDLE
COOLANT
CHANGE PORTS
OVERRIDE

SPINDLE
This command allows you to control the spindle on/off, direction, and spindle speed. After the key word SPINDLE you can enter one or more of the following key words: ON OFF FORWARD REVERSE RPM and PITCH. Make sure to separate words with a space character and that the RPM word is followed by a number 0 to 2500 corresponding to the R.P.M. selected. The PITCH must be followed by the pitch in inches or millimeters and should only be used during a tapping operation. The PITCH selected will automatically adjust the feed rate for the corresponding RPM selected. 300 RPM is the maximum spindle speed allowed for tapping. Also see MAXRPM command.

Ex: SPINDLE ON FORWARD RPM 1500
SPINDLE OFF
SPINDLE ON FORWARD RPM 60 PITCH 18
SPINDLE REVERSE
7.0 MASTER Command List.

The following is a description of all CNC JR. Commands listed in alphabetical order.

$ABSOLUTE
The ABSOLUTE command (AB) sets the absolute mode on. All moves after this command will be relative to the program home position. It can be overridden with the INCREMENTAL command.

$INCREMENTAL
The INCREMENTAL command (IN) cancels the absolute mode and sets the incremental mode. All moves after this command will be relative to the last position. It can be overridden with the ABSOLUTE command.

$IJ_ABSOLUTE
This command overrides the defaulted relative I and J in the ARC, G02, G03 commands.

$ARC_RADIUS
The ARC command (AA) allows you to enter a circular path which will move from the START ANGLE to the END ANGLE at a relative RADIUS. You may select CW or CCW for clockwise or counterclockwise directional move. For the START/END ANGLE, a brief review of the coordinate system follows: (in relation to an operator standing in front of the milling table) Zero (X=0, Y=0) is at the intersection of X and Y coordinate vectors. Given a relative radius, 0 degrees is towards the operators right side (X + relative radius), 90 degrees is away from the operator (Y + relative radius), 180 degrees is towards the operators left side (X -relative radius), 270 degrees is in front of the operator (Y -relative radius).

EX:  ARC_RADIUS .5 STARTANGLE 170 ENDANGLE 285 CCW

$ARCTANGENT
The ARC TANGENT allows you to enter a circular move that continues from a straight move. The straight move could be at any angle. You may select a clockwise or counterclockwise directional move. The arc will extend to the selected ANGLE with a relative RADIUS.

EX:  ARCTANGENT RADIUS 0.768 ENDANGLE 45 CW
corresponding name and will repeat it as indicated by the repeat factor. You may have any number of call commands in a program, but the subroutines must be written after the END command of the main program. Each subroutine starts with the subroutine name and must terminate with an END command. It may contain call commands to other subroutines, but subroutines can not be nested.

EX: CALL DRILL 10
    END
    .
    .
    DRILL
    MOVE Z-.2 F2
    MOVE Z .2 R
    MOVE X.5
    END

$COOLANT
This command turns the system coolant on/off. It may be inserted at any part on your program.

Ex: COOLANT ON
    COOLANT OFF

$DELAY
Allows you to stop the program at a particular point and delay further execution for the time shown in milliseconds. After time out the program will resume.
Ex: DELAY 1000

$END
This command marks the end of your main program or subprogram. CNC JR. will not save a program without an END command in the last program line.

$FEED
The FEED command will activate the default feed rate selected in the Setup file. You may also enter a new feed rate immediately after the word FEED. The feed command will remain effective until overwritten by another feed command or rapid command. The short form of FEED is <F> followed by the feed value. It may be added at the last value of a move command line.

Ex: MOVE X2.0 F10.0

$G
$G20 = \text{Switch Y to W with angular computed displacement} \\
$G27 = \text{Reference point return check} \\
$G28 = \text{Return to reference point} \\
$G29 = \text{Return from reference point} \\
$G70 = \text{Input in inches} \\
$G71 = \text{Input in millimeters} \\
$G80 = \text{Cancel Peck Drilling Cycle} \\
$G83 = \text{Peck Drilling Cycle} \\
$G90 = \text{Absolute move (Modal)} \\
$G91 = \text{Relative move (Modal)} \\
$G92 = \text{Shift X, Y, and Z position} \\
$G98 = \text{Return to initial point in canned cycle} \\
$G99 = \text{Return to R point in canned cycle} \\

$M00 = \text{Stop} \\
$M02 = \text{End routine} \\
$M03 = \text{Spindle on} \\
$M04 = \text{Spindle off} \\
$M08 = \text{Coolant on} \\
$M09 = \text{Coolant off} \\
$M20 = \text{Oil on} \\
$M21 = \text{Oil off} \\
$M30 = \text{End program} \\

For Peck drilling cycle use the following format: \\
G83 X\_\_ Y\_\_ Z\_\_ R\_\_ Q\_\_ P\_\_ F\_\_ \\
X, Y specifies the hole position by an incremental or absolute value. Z specifies the distance from point R to the bottom of the hole with an incremental and negative value, or the position of the hole bottom with an absolute value. \\
R specifies the absolute distance from the initial level value to the R point (return point). After each cut-in value the drill will fast return to the R point. \\
Q specifies each cut-in value with a negative incremental value. P (optional) specifies dwell time in milliseconds at button of the hole. \\
F (optional) specifies feed speed. \\

Peck-drilling example: \\
G91 \\
G99 \\
G83 X.5 Y.7 Z-.5 R-.1 Q-.05 P500 f5 X.5Y-.8 X-.3Y1. \\
G98 \\
X.2Y1 \\
G80
The mirror command allows the X or Y axis to be mirrored. Basically what this command does is reverse the motor direction of the selected axis. To cancel enter MIRROR without any values.

Ex: MIRROR X Y
    MIRROR / to cancel

$MOVE
Here, you may enter your X, Y, Z or W coordinates. The distances may be incremental relative to the last position or absolute relative to zero position, in accordance with the last declared INCREMENTAL or ABSOLUTE commands. You may enter one or more axis on the same command. All axis will interpolate. The speed will be according to the last selected RAPID or FEED command.

\NOTES (NO)
The backslash \ indicates a comment line. Up to 70 characters may be used to add comments or notes to the program. CNC JR. will ignore all text following the backslash during a program run.

$POLAR
Here, you may enter a relative distance in order to move from the current position and the direction of move in degrees.

$PORT
This command will turn the PORT connection between the host computer and the CNC Jr. controller ON or OFF.

Ex: PORT ON
    PORT OFF

Through software control this provides the same function as manually pressing the [F5] to toggle the PORT off or on.

$RAPID
The RAPID command will activate the default RAPID speeds selected in the Setup file. The RAPID speeds will remain in effect until overwritten by a FEED command. The short form is the R letter that can be added as the last parameter on a move command.

Ex: MOVE X1.25 Y.870 R

The word RAPID on the command line must not be followed (except in the Setup file) by any other parameters. In the setup file, the RAPID command must be followed by X, Y, Z and W parameters.
You can also enter S to do software reverse for the spindle rotation if necessary.

$Routine Label (RL)
This command simply adds a blank line at the cursor position on the editing file. Here you may type in a routine label or any other command.

$RUNFILE
With the RUNFILE command you may run an external G-Code file or another CNC Jr. file. If the file is not in the CNC Jr. directory then the correct DOS path must be included with the file name

Ex: C:\MYDIR\MYPROG.CNC

There is a restriction, the RUNFILE command cannot run an external CNC JR. file that contains CALLS or other RUNFILE command.

Ex: RUNFILE C:\BOBCAD\TEST.TAP

$SCALE
The scale command allows either one or all of the axis to be scaled. If a axis does not require a scale factor use a scale of 1.0 to indicate a scale of 1.

Ex: SCALE X2.0 Y2.0 Z1.0 W1.0

$SET
The SET HOME command will move the X, Y and Z axis from the machine home position to the set home values or program home (0,0,0). The SET HOME command must appear as the first line of your program. The SET HOME command will only be active if the axes are at the machine home position. After this, The SET HOME command is deactivated. Press the [ALT]+[S] keys to display the current machine home position. Press the [ALT]+[M] to reset and move to the machine home position.

Ex: SET HOME X-5.98625 Y-3.120000 Z-2.98250

notice that the values are always negative. Also, this command is only available if the machine has switches installed.

$SPINDLE
This command allows you to control the spindle on/off, direction,
SPINDLE OFF
SPINDLE ON FORWARD RPM 60 PITCH 18
SPINDLE REVERSE

$STOP
This command stops the program at a particular point where you will hear a warning sound for a short time to alert the operator about the next step. To continue with the program you may press [Enter] or [Ctrl]+[F9] or [Esc] to terminate the program. This command can be used for a tool change.

$TOOL
This command is designed to work with the Quick Tool Change System.
T01 to T10 are variables for tool height offsets stored in the SETUP file.

Ex: TOOL T01=-.100 T05=.567 T03=1.2 ... etc.

To incorporate a tool change on your program, follow this guidelines: Move the quill up on the Z axis, high enough to clear your work and change the new tool. Stop your program at this point and advice the operator about the tool change. Following the tool change, enter the tool offset and move the Z axis down the same distance you previously used to clear the work area.

Ex: (other code)
MOVE Z 2.5 R
STOP /CHANGE TOOL T03
TOOL T03
MOVE Z-2.5
(continue code)

Use the T00 to cancel the tool offset and bring the quill back to the original position.

Ex: TOOL T00

$TOOL_RIGHT
The Tool_Right command is not implemented. Please check with J&S PRODUCTS for future release.

$TOOL_LEFT
The tool_Left command is not implemented. Please check with J&S